Western blot practical instructions

Sample Preparation (this bit has already been done for you)

Carry out procedure on ice:

1) Prepare RIPA lysis buffer:
· 980ul RIPA buffer (ThermoFisher, catalogue code 89900) 
· 10ul of 100x protease inhibitor mix (HALT ThermoFisher, catalogue code 78440
· 10ul 0.5M EDTA phosphatase inhibitor (HALT ThermoFisher, catalogue code 78440)
· Vortex to mix.

2) Add 150ul of prepared RIPA lysis buffer to a HeLa cell pellet (containing ~6 million cells) and resuspend pellet by mixing up and down.

3) Sonicate sample for 3 x 10s in a sonicating water bath (containing iced water). Vortex to mix.

4) Centrifuge the sample at 4oC for 20 minutes to pellet debris. Remove the supernatant and keep for Western blot. Discard any debris / pellet.

5) Quantify sample supernatant using Qubit Protein BR Assay kit, Thermo A50668 (or protein assay kit such as BioRad DC Protein Asay Kit, BioRad catalogue code 5000111)
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6) Add 2 x Tris-Glycine Sample Buffer and 10 x Sample Reducing Agent to prepared HeLa sample (from step 4) to create a HeLa sample in 1 x Tris-Glycine Sample Buffer:
· 100ul HeLa sample in RIPA lysis buffer
· 80ul 2x Tris-Glycine Sample buffer
· 20ul 10x Sample Reducing Agent 

7) Make up 1X Tris-Glycine Sample Buffer by diluting 2X Tris-Glycine Sample Buffer (Thermo catalogue code LC2676) in RIPA lysis buffer + inhibitors from step (1) and add 10x Sample Reducing Agent:

1x Tris-Glycine Sample Buffer:
· 450ul 2x Tris Glycine Sample buffer
· 450ul RIPA buffer + protease and phosphatase inhibitor (from step 1)
· 100ul 10x Sample Reducing Agent

8) Prepare a 1:2 dilution series of sample to show how protein expression changes can be visualised on a gel:
· Add 50ul of 1 x Tris-Glycine Sample Buffer prepared in step (7) to 50ul of HeLa sample prepared in step (6), vortex to mix, and then dilute 1:2 again until 4 x 1:2 dilutions of HeLa sample have been created.
· Vortex dilutions as they are made.

9) Heat-inactivate the samples for 10 minutes at 70oC (e.g., using a heat-block). Samples can then be frozen at this stage if not needed immediately (-80oC for long-term storage or -20oC for shorter term storage) or proceed directly to running the gel.

Recipes:
RIPA buffer
25 mM Tris HCl pH 7.6
150 mM NaCl
1% NP-40
1% sodium deoxycholate
0.1% SDS

Tris Glycine Sample Buffer
2x Tris-Glycine Sample Buffer Recipe:
100mM Tris HCl, pH 6.8
4% SDS
0.2% Bromophenol blue
20% Glycerol
DTT to a final concentration of 50mM should be added just before use 





Day 1.
Setting Up and Running Mini-PROTEAN Gels in the Mini-PROTEAN Tetra Cell using pre-cast gels
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· Make running buffer (1L).  Dilute 100ml 10x stock with 900ml deionised water.
Running buffer recipe (1X) 
25mM Tris
192 mM Glycine
0.1% SDS.

1) Remove the gels from the storage pouch and prepare them for assembly:
a. 	Remove the comb: Position thumb on the indentation (middle of comb) and remove the comb by pulling upward in one smooth motion.
b. 	Remove the tape: Pull gently to remove the green tape from the bottom of the cassette. If necessary, use the opening key or comb to help remove the tape at the corners.
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2. Set the electrode assembly to the open position on a clean, flat surface (A). 
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3. 	Place the gel cassettes into the electrode assembly (B). Two cassettes are required to create a functioning assembly; when using 1 or 3 gels, use a buffer dam (included with the cell) to complete the assembly:

a. 	Place the first cassette with the short plate facing inward and so the gel rests at a 30° angle away from the centre of the electrode assembly. Make sure the electrode assembly remains balanced and does not tip over. 
b. 	Place the second gel or buffer dam on the other side of the electrode assembly, again by resting the gel on the supports. The gels rest at 30° angles, one on either side of the electrode assembly, tilting away from the centre of the frame (B). 
c. 	Rinse the wells: Use a disposable Pasteur pipet to rinse the wells with 1 x running buffer. Straighten the sides of the wells, if necessary. 
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4. 	Gently push both gels toward each other, making sure that they rest firmly and squarely against the green gasket that is built into the electrode assembly. Align the short plates to ensure the edge sits just below the notch at the top of the green gasket (C). 
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5. 	While gently squeezing the gel cassettes (or cassette and buffer dam) against the green gaskets (maintaining constant pressure and with both gels in place), slide the green arms of the clamping frame one at a time over the gels, locking them into place (D,E). 
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6. The wing clamps of the electrode assembly lift each gel cassette up against the notch in the green gasket, forming a seal. Check again that the short plates sit just below the notch at the top of the green gasket (C). 

If running more than 2 gels, repeat steps 2–6 with the companion running module.
7. Place the electrophoresis module into the tank (F) and fill the buffer chambers with 1x running buffer: 200 ml in the inner buffer chamber, 550 ml (1–2 gels) or 800 ml (3–4 gels, or >200 V) in the outer buffer chamber. Add a magnetic flea to the bottom of the tank and place on a magnetic stirrer platform. 
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8. Wash the sample wells with running buffer (if this was not done earlier). 
9. If samples have been frozen, thaw and heat inactivate at 70oC for 10 minutes. Vortex to mix. If samples have been freshly prepared, they should have already been heat inactivated as part of the sample preparation method (step 9 of p.2).
9. Load 10ul BioRad Dual Colour protein standards (BioRad, catalogue code 1610374) and 6.2ul pre-prepared samples (to give 30ug, 15ug, 7.5ug and 3.75ug respectively). 
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10. Place the tank lid with the electrodes correctly positioned in the powerpack (red to red and black to black), and run the gels at a constant voltage of 150V for ~1.5 hours. Stop the run when the blue dye front reaches the reference line imprinted on the bottom of the cassettes, or the bottom of the gel.
Removing the Gel
1. 	After electrophoresis is complete, turn off the power supply and disconnect the electrical leads.
2. 	Remove the lid from the tank and remove the gels from the cell. Pour off and discard the running buffer.
3. 	To open the cassette, align the arrow on the opening lever with the arrows marked on the cassette and insert the lever between the cassette plates at indicated locations. Apply downward pressure to break each seal. Do not twist the lever. 
4. Pull the two plates apart from the top of the cassette, and use a gel knife to remove the wells at the top (these can fold over and cause problems during transfer). Gently remove the gel and place in a plastic dish containing Tris-Glycine Transfer Buffer.

Transfer of proteins 
Tris Glycine Transfer Buffer recipe (1X):
25 mM Tris, 192 mM glycine
20% (v/v) methanol (pH 8.3) 

Dilute 100 ml 10x stock (catalog #161-0734) with 400 ml diH2O. Add 200 ml methanol, then adjust volume to 1 L with deionised H2O. 
Note: you can add SDS to 0.1% to promote transfer of high molecular weight proteins. 
Wet Transfer Using the Mini Trans-Blot® Module 
1. Equilibrate the gels in transfer buffer for 10–20 min prior to blot assembly. 
2. Assemble the Mini Trans-Blot cassette. Place the gel closest to the black plate and the membrane closest to the clear plate of the cassette. Use a roller to remove air trapped between the layers of the blot assembly.
Note: If using PVDF membrane, pre-wet PVDF in 100% methanol before soaking in transfer buffer.
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3. Place the assembled cassette into the transfer module and tank. The clear cassette plate should face the red side of the transfer module, and the black plate should face the black side of the transfer module. Repeat steps 2 and 3 for a second blot, if needed. 
4. Add the cooling unit and magnetic flea and fill the tank with transfer buffer. Place the tank on a magnetic stirring plate and begin stirring to maintain even buffer temperature and ion concentration during the transfer. 
5. Connect the Mini Trans-Blot cell to a suitable power supply and begin transfer at 100V for 1 hour. 
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6. Once transfer is complete, undo the transfer sandwich and remove the membrane using membrane tweezers. Mark the corner of the membrane with a pencil (to indicate protein-side up), trim the bottom of the membrane if necessary using a scalpel, and place in a plastic box containing deionised water or PBS buffer to wash off the transfer buffer. 

7. Proceed to immunodetection.

Immunodetection

1. Prepare a solution of milk blocking solution:
· Prepare 1L of PBS + 0.1% Tween 20 (Add 1ml of Tween 20. Note, Tween is very viscous and slow to pipette!).
· Weigh out 5g Marvel Milk Powder, and dissolve in 100ml PBS + 0.1% Tween solution using a magnetic flea on a magnetic stirrer platform. Dissolve for at least 30 minutes to ensure the milk powder is fully dissolved before use.

2. Pour off the water or PBS solution used to wash the membrane after transfer.

3. Add 10ml prepared 5% Marvel milk powder in PBS + 0.1% Tween per membrane to the plastic box to block the membrane. Incubate on a rocker platform for 1 hour at room temperature.

4. Pour off the blocking solution and replace with PBS + 0.1% Tween for overnight storage in the fridge.

Day 2. 

5. Prepare 6mls primary antibody solution:
· Dilute anti-actin antibody 1:1000 in blocking buffer (5% Marvel in PBS + 0.1% Tween).

6. Pour off the PBS + 0.1% Tween used to store the membrane in overnight, and add the primary antibody. Incubate on a rocker platform for 1 hour at room temperature.

7. Pour off the primary antibody solution (note: primary antibody can be re-used over a few days if necessary. (Keep the antibody in the fridge to prevent the milk solution from turning bad).

8. Wash the membrane in PBS + 0.1% Tween, 4 x 5 minutes.

9. While washing, prepare the secondary antibody:
· Dilute anti-rabbit-HRP 1:10,000 in blocking buffer (5% Marvel in PBS + 0.1% Tween).

10.  Incubate the membrane in diluted secondary antibody for 1 hour at room temperature.

11. Wash the membrane 4 x 5 min in PBS + 0.1% Tween.

12. Image the membrane by adding 10ml TMB substrate (Thermo catalogue code 37574) and wait for the signal to appear (should take ~5 minutes). Once the signal can be see, pour off the TMB substrate and wash with deionised water to stop the reaction.

13. Take a picture of the membrane and convert to greyscale ready for analysis.

Analysis of protein bands using Image J software
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1.  Download Image J software if you don’t already have this on your computer. ImageJ is a Java based (runs on all operating systems) freeware by Wayne Rasband from National Institute of Health (USA) and is available for download at: http://rsb.info.nih.gov/ij/

2. Set the Measurement Criteria: Under the “Analyze” menu select “Set Measurements”. From the checkboxes have ONLY the “Grey Mean Value” ticked.
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3. Prepare the Image: Go to the “File” menu and open the JPEG file format for the film. Maximize the window and use “+” / “-“ or “↑” / ”↓” keyboard shortcuts to zoom. Use an appropriate zoom level. For spanning the image around in zoom mode select the “hand” tool from the ImageJ toolbox. (If you maximized the screen, the toolbox may be hiding in the background). 
4. Define the area of interest: If there are multiple proteins of interest on your film, for each row of protein band across the lanes you need to define a single region of interest. Do this one row of protein at a time. 
· Select the “rectangle” tool from ImageJ and draw a frame around the largest band of that row. You can drag around and resize the frame. 
· Adjust it so that it covers the minimum area to contain the whole of the largest band of the row (sometimes a band may not be flat so you have to allow more area to include all of it). 
· Once you have the frame sized properly, click the “File” menu, “Save as”, “Selection” and save this frame with the protein name. 
· If other band rows (other protein) are present define and save a frame (ROI) for those as well. You need to do the same for the loading control bands as well. 

5. Take measurements: 
· For each protein (row) to take measurements you will start at the first lane and use the same frame for all of the protein bands across the other lanes. It is very important that you use the same frame across a row. If you accidentally resize the frame or lose it you can go to “Open” under the “File” menu and reimport the same frame. 
· Place the frame on the first band. The frame should fit all the bands since you previously sized it according to the largest one. Centre the band inside the frame and use the “Ctrl”+”M” keyboard shortcut to record a measurement (“Command”+”M” on Mac or alternatively by clicking “Measure” under the “Analyze” menu). This will open the measurement window and display your data in order. Move the frame to the next lane and make measurement for that protein for all your samples (across the row). 
· When you finish a row export the data into a spreadsheet (e.g. Microsoft Excel) keeping track of which value belongs to which sample. Close the measurement window of ImageJ to clear the outputs. 
· With the same frame as the protein (row) you will now take a background measurement. To do so place the frame above or below every band in the row, in a place where there are no other bands or stains on film. Record measurements and export them into the spreadsheet. 
· Export all measurement data into excel. 

Analysis of data in Excel

When you have all the data for the bands and their backgrounds along with the loading control bands and their backgrounds in your spreadsheet you need to write a few formulas to do the calculations:

· Invert the pixel density for all data (bands/controls + their backgrounds) in new columns. The inverted value is expressed as 255 – X, where X is the value recorded by ImageJ. For example if the pixel density recorded by ImageJ is 234.5 then the inverted value should return 20.5. 
· For the protein bands and loading controls, express the net value by deducting the inverted background from the inverted band value. For example, after doing the inversions if one band has a background of 3 and band value of 20.5 then the net value should return 17.5. 
· When the net bands and loading controls are calculated as the final step, take a ratio of a net band value over the net loading control of that lane. For example, if you had a net band value of 17.5 and a net loading control value of 4.5 for that protein band lane then the ratio is 17.5 / 4.5 = 3.88. 


Manually pouring a gel

If not using pre-cast gels, you will need to pour your own gels to use in advance of your Western blot.

Preparing the glass plates

All glass plates should be clean and dry. 

1. Place a green casting frame upright with the pressure cams in the open position and facing forward on a flat surface. 
2. Select a spacer plate of the desired gel thickness and place a short plate on top of it (see Figure 3a). 
3. Orient the spacer plate so that the labelling is up. Slide the two glass plates into the casting frame, keeping the short plate facing the front of the frame (side with pressure cams) (see Figure 3b). Note: Ensure that both plates are flush on a level surface and that the labels on the spacer plate are oriented correctly. Leaking may occur if the plates are misaligned or oriented incorrectly. 
4. When the glass plates are in place, engage the pressure cams to secure the glass cassette sandwich in the casting frame (see Figure 3c). Check that both plates are flush at the bottom. 
5. Place the green casting frame into the casting stand by positioning the casting frame (with the locked pressure cams facing out) onto the grey casting gasket while engaging the spring-loaded lever of the casting stand onto the spacer plate (see Figure 3d).

Note: The grey casting stand gaskets must be clean and dry. The casting stand gaskets are made of a special thermoplastic material that swells when soaked in water, so do not soak the gaskets for prolonged periods prior to casting. If the gaskets do get accidentally soaked and display swelling and/or deformation, just allow them to air dry and they will regain their original shape, size and performance.
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Gel Casting 

1. Place a comb into the assembled gel cassette. Mark the glass plate 1 cm below the comb teeth. This is the level to which the resolving gel is poured. Remove the comb. 
2. Prepare the resolving gel solution by combining all reagents except APS and TEMED. 
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3. Add APS and TEMED to the solution and pour to the mark using a plastic stripette. Pour the solution smoothly to prevent it from mixing with air.
4. Immediately overlay the solution with absolute (100%) ethanol. 
5. Allow the gel to polymerize for 45 min to 1 hr. Rinse the gel surface completely with distilled water. Do not leave the alcohol overlay on the gel for more than 1 hr because it will dehydrate the top of the gel. 

Note: At this point the resolving gel can be stored at room temperature overnight. Add 5 ml 1x resolving gel buffer on top of the gel and seal with parafilm (to prevent evaporation) for storage. 

6. Prepare the stacking gel solution. Combine all reagents except APS and TEMED. 
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7. Dry the top of the resolving gel with filter paper before pouring the stacking gel. 
8. Add APS and TEMED to the stacking gel solution and pour the solution between the glass plates. Continue to pour until the top of the short plate is reached.
9. Insert the desired comb between the spacers starting at the top of the spacer plate, making sure that the tabs at the ends of each comb are guided between the spacers. Seat the comb in the gel cassette by aligning the comb ridge with the top of the short plate.
10. Allow to set for 30-45 minutes. 
11. Remove the gels from the casting stand and proceed to setting up the BioRad Protean Tetra Cell.
2
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f. Repeat steps a—e for additional gels.

Fig. 3. Assembling the Mini-PROTEAN casting stand and frame.
2.0 Gel Casting
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TABLE A8-9 Solutions for Preparing Resolving Gels for Tris-glycine SDS-Polyacrylamide Gel Electrophoresis
VOLUME (ml) OF COMPONENTS REQUIRED TO CAST GELS
OF INDICATED VOLUMES AND CONCENTRATIONS

4 componets /GeL Vowume = 5 ml 10 ml 15 ml 20 ml 25 ml 30 ml 40 ml 50 ml
% gel .

H,0 2.6 53 7.9 10.6 132 15.9 212 26.5
30% acrylamide mix <!> 1.0 2.0 3.0 4.0 5.0 6.0 8.0 10.0
1.5 M Tris (pH 8.8) 1:3 25 3.8 5.0 6.3 7.5 10.0 12,5
10% SDS 0.05 0.1 0.15 0.2 0.25 03 0.4 0.5
10% ammonium persulfate <!> 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
TEMED <!> 0.004 0.008 0.012 0.016 0.02 0.024 0.032 0.04
8% gel
H,0 23 4.6 6.9 9.3 115 13.9 18.5 232
30% acrylamide mix <!> 13 27 4.0 53 6.7 8.0 10.7 13.3
1.5 M Tris (pH 8.8) L3 25 3.8 5.0 6.3 7.5 10.0 125
10% SDS 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
10% ammonium persulfate <!>  0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
TEMED <!> 0.003 0.006 0.009 0.012 0.015 0.018 0.024 0.0.
10% gel
H,0 19 4.0 5.9 7.9 9.9 11.9 15.9 19.8
30% acrylamide mix <!> 1.7 33 5.0 6.7 8.3 10.0 13.3 16.7
1.5 M Tris (pH 8.8) 13 25 3.8 5.0 6.3 75 10.0 12,5
10% SDS 0.05 0.1 0.15 0.2 0.25 03 0.4 0.5
10% ammonium persulfate <!> 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
TEMED <!> 0.002 0.004 0.006 0.008 0.01 0.012 0.016 0.02
12% gel
H,0 16 33 4.9 6.6 8.2 9.9 132 16.5
30% acrylamide mix <!> 2.0 4.0 6.0 8.0 10.0 12.0 16.0 20.0
1.5 M Tris (pH 8.8) 13 25 3.8 5.0 6.3 7.5 10.0 12.5
10% SDS 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
10% ammonium persulfate <!> 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
TEMED <!> 0.002 0.004 0.006 0.008 0.01 0.012 0.016 0.02
15% gel
H,0 11 23 34 4.6 57 6.9 9.2 115
30% acrylamide mix <!> 25 5.0 7.5 10.0 12.5 15.0 20.0 25.0
1.5 M Tris (pH 8.8) 13 25 3.8 5.0 6.3 7.5 10.0 12.5
10% SDS 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
10% ammonium persulfate <!> 0.05 0.1 0.15 0.2 0.25 0.3 0.4 0.5
TEMED <!> 0.002 0.004 0.006 0.008 0.01 0.012 0.016 0.02

Modified from Harlow and Lane (1988).

TABLE A8-10 Solutions for Preparing 5% Stacking Gels for Tris-glycine SDS-polyacrylamide Gel Electrophoresis

VoLUME (ml) OF COMPONENTS REQUIRED TO CAST GELS OF INDICATED VOLUMES

components /Get Vowume = 1 ml 2 ml 3 ml 4 ml 5 ml 6 ml 8 ml 10 ml
H,0 0.68 14 2.1 2.7 34 4.1 55 6.8
30% acrylamide mix <!> 0.17 0.33 0.5 0.67 0.83 1.0 1.3 1.7
1.0 M Tris (pH 6.8) 0.13 0.25 0.38 0.5 0.63 0.75 1.0 1.25
10% SDS 0.01 0.02 0.03 0.04 0.05 0.06 0.08 0.1
10% ammonium persulfate <!> 0.01 0.02 0.03 0.04 0.05 0.06 0.08 0.1
TEMED <!> 0.001 0.002 0.003 0.004 0.005 0.006 0.008 0.01

Modified from Harlow and Lane (1988).
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